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Upgrading to Octel® 100 Version 3.2 from Octel Overture PC/Octel
Signature Performer 1.0 and Higher

This note provides the following steps for upgrading systems to Octel 100 Version 3.2
from Octel Overture PC/Octel Signature Performer 1.0 and higher.

WARNING: Octel 100 Version 3.2 must be run on a Pentium-level PC. If the
messaging system is not currently running on a Pentium-level PC, you
must first migrate to a Pentium PC before beginning the software
upgrade to Octel 100 Version 3.2. Steps for migrating to a Pentium-level
PC are provided in a separate note titled, “Migrating an Existing Octel
Messaging System to a Pentium PC,” (part number 101-1880-000). For
information on migrating to a Pentium PC, please contact your
authorized representative. If you are not sure whether migration to a
Pentium PC is required, contact a technical support representative.

Steps for installing OS/2 Fix Pak 40 are also provided. You must install Fix Pak 40 before
you upgrade to Octel 100 Version 3.2, unless you migrated to a new PC or you
purchased the upgrade to OS/2 Warp 4.0.

Required Materials

The following materials may be required for the upgrade. Make sure that you have the
required materials available before beginning the upgrade:

• A medium you can use to back up files on the system, such as diskettes or a
tape backup device (make sure that if you are migrating to a new PC that the
medium you select is supported on both PCs)

• Any hardware required to upgrade the system, including voice or fax boards,
RAM, or a Sentinel device, as well as accessory tools you may need, such as a
screwdriver

• A sentinel upgrade utility (SUU) , if adding optional modules

• An anti-static wrist strap, if you will be handling voice or fax boards

• BackPak external CD-ROM and BackPak disk (only if the PC is not equipped
with an internal CD-ROM drive)

• Octel 100 v3.2 Upgrade

• The PC manufacturer’s documentation, if you are upgrading RAM

• Octel 100 Version 3.2 Implementation and Service Manual
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 Procedures in this note assume that the hard drive on which the system is installed is
drive C, that any additional hard drive that may be installed is D, that the disk drive is A,
and that the CD-ROM drive, if installed, is E. Drive designations on the specific PC on
which you are working may vary. Confirm the appropriate drive letters, when necessary,
in procedures provided in this note.

Upgrade Considerations

 Be aware of the following considerations before beginning the upgrade:

• A BackPak external CD-ROM is used for upgrades on PCs that don’t have an
installed CD-ROM drive. Instructions for connecting and using the BackPak are
provided in the upgrade procedure.

• Call handling changes made in previous versions may affect how call flow
applications are set up after you upgrade the system. For comprehensive call flow
functionality matrices for the current version of the software, see Prompts Voiced
Under Specific Call Handling Conditions in Chapter 24, “Troubleshooting the
System,” in the Implementation and Service Manual.

• On systems upgrading from version 1.0x, group distribution lists are converted to
accommodate 50 mailboxes per list.

• On systems upgrading from version 1.0x, settings for the INRINGS and inbound and
outbound channels are carried over to a new Port Parameters tab in System Setup.
You must enable the Application option for each port that is allowed to use V-Edit in
Visual Architect or Visual Mailbox.

• Existing V-Trees, whether they were created on screen or through the keypad
interface, are converted to accommodate the new Visual Architect V-Tree generation
tool on systems using Visual Architect.

• Message Confirmation data is not retained after the conversion.

• Octel 100 supports Daylight Savings Time. If your PC or other software packages
support this feature, be sure to deactivate this feature in Octel 100. Note that this
feature is based on North American standards. If the messaging system location is
based on a different standard, disable this feature in Octel 100 and enable it on the
PC or in another software package, if available.

• On systems upgrading from version 1.0x, new features, such as Follow-Me-Forward
on the Class of Service dialog box and Personal Fax Number on the Subscriber
Settings dialog box will be set to the Octel 100 default values.

• If you are upgrading from OPC Version 1.02 and there are fax events that have not
yet occurred, the events will be successfully performed after the conversion.
However, fax errors may be written to the log file even though the events were
successful. If this occurs, ignore these errors.

WARNING: On existing Octel systems that have custom phrase files in the
ENGLISH1.O32 or ENGLISH2.O32 files, you must use V-Edit to
manually restore the custom phrases after the upgrade is complete. This
is required because new phrases have been added to the messaging
system and the phrases may not have the same assigned number.
Therefore, you must back up the phrase files and compile a list of the
custom phrase numbers before you perform the upgrade.
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Setting Up the BackPak CD-ROM Drive

The BackPak external CD-ROM is a portable CD-ROM drive that can be used on
systems that do not already have a CD-ROM installed. A CD-ROM is required for
software installation.

If the system already has an installed CD-ROM, you can skip to the procedure titled,
“Installing OS/2 Fix Pak 40.)

If the system does not have a CD-ROM and you did not receive a BackPak drive with the
Octel 100 3.2 software upgrade, contact your authorized representative.

To prepare the system to use the BackPak CD-ROM:

1. Complete the following steps to copy the files necessary to run the BackPak to the
PC:

a. Turn on the PC if it is not already running.

b. If the messaging system launches automatically, shut it down.

c. Insert the disk labeled BackPak CD-ROM Disk in the PC’s disk drive.

d. Open an OS/2 window and, from the C: prompt, type A: and press <ENTER>.
The A: prompt displays.

e. From the A: prompt, type BPADD and press <ENTER>. The necessary files are
copied to the PC. When the files are copied, a message displays warning you
not to run the BPADD command again. It is very important that you run this
command only once. Otherwise, the PC will not operate properly.

f. Remove the disk from the disk drive.

g. Type EXIT and press <ENTER> to close the OS/2 window.

2. Shut down the PC:

a. Select Shutdown from the LaunchPad. When you are prompted whether you
want to close all windows and active programs, click OK.

b. When prompted, turn off power to the PC.

3. Connect the BackPak CD-ROM to the messaging system PC:

a. If a printer is currently attached to the messaging system Sentinel, disconnect
the printer cable from the back of the Sentinel.

b. Connect one end of the BackPak CD-ROM cable into the Sentinel and the other
end into the port marked “Computer” on the back of the BackPak CD-ROM.

c. Attach the power cable to the power connector on the BackPak CD-ROM and
plug the BackPak power unit into a wall outlet.

4. Turn on power to the PC. If the messaging system launches automatically, shut it
down.
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Installing OS/2 Fix Pak 40

OS/2 Warp Fix Pak 40 must be installed on PCs running OS/2 Warp 3.0. IBM issued Fix
Pak 10 to address OS/2 Warp 3.0 operating system anomalies.

WARNING: If you migrated to a new PC or you purchased the upgrade to OS/2
Warp 4.0, you must NOT install OS/2 Fix Pak 40. Fix Pak 40 should only
be installed on systems running OS/2 Warp 3.0.

To install OS/2 Warp Fix Pak 40:

1. Shut down the messaging system if it is running.

2. Insert the CD-ROM labeled “Octel 100 v3.2 Upgrade” in the CD-ROM drive.

3. Open an OS/2 window if one is not already open.

4. From the C: prompt, type E: and press <ENTER>.

5. From the E: prompt, type instfp40 and press <ENTER>. The OS/2 Warp Fix Pak
40 install begins.

6. When the file update is complete, the OS/2 window displays a message that the Fix
Pak 40 file transfer is complete. Press any key to continue.

7. Remove the CD-ROM from the CD-ROM drive.

8. To close the OS/2 window, type EXIT and press <ENTER>.

9. Restart the PC:

a. Click the right mouse button on an empty area of the OS/2 desktop and select
Shut down from the menu that displays.

b. When you are prompted whether you want to close all windows and active
programs, click OK.

c. When prompted to shut down or reboot, press <CTRL+ALT+DEL> to restart the
PC. Once the PC restarts and the OS/2 desktop displays, complete the
procedure to perform the upgrade to Octel 100 Version 3.2.
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Preparing for the Upgrade to Octel Version 3.2

1. Shut down the messaging system if it is running:

a. Log into the messaging system as a Level 2 or 3 supervisor.

b. To shut down the system, select Exit from the File menu. A dialog box displays a
message prompting you to indicate how to shut down the system.

c. Click OK to perform the shutdown. A dialog box displays a message asking if
you want to wait for channel activity to cease. Wait for channel activity to cease.
Do not click Force. When all the ports are inactive, the system shuts down.

 If you completed the steps in the note, “Migrating an Existing Octel Messaging
System to a Pentium PC,” skip to the procedure, “Performing the Upgrade to Octel
100 3.2.”

2. You must run the Configure utility to record the settings of the installed voice boards:

a. Double-click the Configure icon in the Octel folder. The Configure dialog box
displays. Under Installable Hardware, select the type of voice board installed in
the messaging system and click Configure. The Configure dialog box displays
the board information.

b. Record the following information, which you will need to reenter after the
upgrade is complete:

 Voice Board Type                                                                            

 Hardware Interrupt                                                                            

 Shared Memory Addresses                                                                            

c. Click Cancel. The Configure dialog box displays.

d. Click Exit. You are prompted to reboot the system for changes to take effect. Do
not reboot at this time  since you made no change.

3. Run Quick Assist in Update (Partial) mode

a. Double-click the Octel icon to open the Octel folder.

b. Double-click the Quick Assist icon in the Octel folder. The Quick Assist dialog
box displays.

c. Click Recover Files. The Recover Files dialog box displays.

d. In the Drive where \cvr1 files are located field, verify that the displayed drive is
the drive where the \CVR1 directory is located.

e. In the Mailbox to receive unattached messages field, enter the mailbox in which
you want the system to place messages with invalid header information.
(Unattached messages with valid header information are placed in the new
message queue of the receiving mailbox.) Messages are only put in this mailbox
if the Delete unattached messages option is disabled.

f. Under Recovery Mode, select the Update (partial) option.

g. Under Recovery Options, select the Ask before creating a mailbox option if you
want the system to prompt you for confirmation before it creates mailboxes. The
system creates mailboxes when it finds messages or greetings that are linked to
a mailbox number that does not exist. If you deselect this option, the system
automatically creates the mailboxes indicated by the message or greeting links.
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h. Under Recovery Options, select the Delete unattached messages option if you
want the system to automatically delete unattached messages. If you disable this
option, unattached messages with valid header information are placed in the
mailbox in the message header, and unattached messages with invalid header
information are placed in the mailbox you specified in step 4e.

i. In the Report Filename field, enter the name of the report you want the system
to generate. The default is QASSIST.RPT.

j. Under Report Options, select the Send to File option if you want to create a
report file. When you select this option, the system creates a report with the
specified filename in the \CVR1 directory. If you deselect this option, the report
is only available by selecting the View Report option.

k. To begin the update, click Start. The Recover Status dialog box displays. The
system copies the files in the \CVR1 directory into a directory named
\~REPAIR~. Do not delete the files from the \~REPAIR~ directory until you are
confident the system has corrected any file damage.

l. The Searching Directory and Processing Mailbox fields display the directory and
mailbox currently being processed. The Errors and Warnings fields reflect the
respective number of errors and warnings the system encounters during the
update.

m. When the partial update is complete, you can click Edit Mailboxes to reenter or
modify information that may have been lost. The Mailbox Quick Edit dialog box
displays with information for the first mailbox.

 This dialog box includes general identification information about each system
mailbox, including the First and Last Name, Company, and Division. The
Messages box displays the number of recovered New and Saved messages.

 You can click the Next and Previous buttons to move through the mailboxes.
Click Save to save any edits you make. When you finish making any edits, click
OK to return to the Recover Status dialog box.

n. Click OK. The Recover Files dialog box displays.

o. To display the report, click View Report. If the system detected errors or
warnings during the update, the appropriate corrective action is suggested in the
report. If Quick Assist recommends further action, such as performing an Update
All or Rebuild All, contact a technical support representative before continuing.

p. When you finish viewing the report, click the window icon in the upper-left corner
and select Close. The Recover Files dialog box displays.

q. Click Cancel. The Quick Assist dialog box displays.

r. To close Quick Assist, click Exit.

s. Double-click the icon in the upper-left corner of the folder window to close it.

4. Verify that there is sufficient space on the hard drive for the upgrade:

a. Open an OS/2 window.

b. From the C: prompt, type DIR and press <ENTER>. At the end of the file
listing, the bytes free is listed.

c. Verify that there is at least 100,000,000 bytes free (100MB). If there is not at
least 100,000,000 bytes free, contact a technical support representative before
continuing.

d. Type EXIT and press <ENTER> to close the OS/2 window.
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5. If you are using a BackPak external CD-ROM to upgrade, complete the following
steps to copy the files necessary to run the BackPak to the PC:

a. Insert the disk labeled BackPak CD-ROM Disk in the PC’s disk drive.

b. Open an OS/2 window and, from the C: prompt, type A: and press <ENTER>.
The A: prompt displays.

c. From the A: prompt, type BPADD and press <ENTER>. The necessary files are
copied to the PC. When the files are copied, a message displays warning you
not to run the BPADD command again. It is very important that you run this
command only once. Otherwise, the PC will not operate properly.

d. Remove the disk from the disk drive.

e. Type EXIT and press <ENTER> to close the OS/2 window.

6. Shut down any open applications (for example, UPS, SMDI) and windows except the
OS/2 desktop and the OS/2 window:

a. Press <CTRL+ESC> to open the Window menu.

b. Highlight any application you see with the exception of the OS/2 desktop or the
OS/2 window.

c. Click the right mouse button once on the open application.

d. Select Close.

e. Repeat steps 6a – d for each open application.

7. Shut down the PC:

a. Click the right mouse button on an empty area of the OS/2 desktop and select
Shut down from the menu that displays.

b. When you are prompted whether you want to close all windows and active
programs, click OK.

c. When prompted to shut down or reboot, turn off power to the PC.

8. If you are using the BackPak CD-ROM for the upgrade:

a. If a printer is currently attached to the messaging system Sentinel, disconnect
the printer cable from the back of the Sentinel.

b. Connect one end of the BackPak CD-ROM cable into the Sentinel and the other
end into the port marked “Computer” on the back of the BackPak CD-ROM.

c. Attach the power cable to the power connector on the BackPak CD-ROM and
plug the BackPak power unit into a wall outlet.

WARNING: Use caution when handling boards, such as voice boards or network
interface cards, as they are electrostatic-sensitive. Be sure you ground
the PC, the work area, and the ground end of the antistatic wrist strap
prior to handling a board, and always use antistatic wrist straps and/or
electrostatic-dissipative mats while handling a board.

9. Complete the following steps if you need to perform hardware upgrades

a. Remove the cover of the PC, if necessary. See the PC manufacturer’s
documentation for information on removing the PC’s cover.

b. If you are installing new voice or fax boards, see Chapter 5, “Preparing the
Hardware,” in the Implementation and Service Manual. If you are not installing
new voice or fax boards, proceed with step 9d.
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c. If you installed new voice or fax boards, record the settings of the boards such
as the hardware interrupt and port address, as applicable. You will need to enter
this information when you run the Configure utility.

d. If you are adding RAM to the PC, make sure that you modify the PC’s BIOS
before continuing with the upgrade. For additional information on modifying the
BIOS, see the PC manufacturer’s documentation.

e. After the hardware upgrades are completed, replace the PC’s cover.

10. Turn on the PC. If the messaging system is configured to launch automatically on
bootup, it launches. If the messaging system is not configured to launch
automatically on bootup, the OS/2 desktop displays.

Performing the Upgrade to Octel Version 3.2

1. Shut down the messaging system if it is running:

a. Log into the messaging system as a Level 2 or 3 supervisor.

b. To shut down the system, select Exit from the File menu. A dialog box displays a
message prompting you to indicate how to shut down the system.

c. Click OK to perform the shutdown. A dialog box displays a message asking if
you want to wait for channel activity to cease. Wait for channel activity to cease.
Do not click Force. When all the ports are inactive, the system shuts down.

2. Run the Sentinel Upgrade Utility, if provided:

a. Insert the Sentinel Upgrade diskette in the A drive.

b. Open an OS/2 window.

c. At the C:\ prompt, type A: and press <ENTER>.

d. At the A:\ prompt, type SUU and press <ENTER>. When the upgrade procedure
is finished, the message “Sentinel upgrade successful” displays.

e. Remove the Sentinel upgrade diskette from the diskette drive.

f. Type EXIT and press <ENTER> to close the OS/2 window.

3. Shut down any open applications (for example, UPS, SMDI) and windows except the
OS/2 desktop:

a. Press <CTRL+ESC> to open the Window menu.

b. Highlight any application you see with the exception of the OS/2 desktop.

c. Click the right mouse button once on the open application.

d. Select Close.

e. Repeat steps 3a – d for each open application.

4. Insert the CD-ROM labeled “Octel 100 v3.2 Upgrade” into the CD-ROM drive.

 Do not attempt installation from the full screen OS/2 window because the installation
process will run in the background, and the installation screens will not be visible to
you. Consequently, you cannot follow the prompts.

5. Open an OS/2 window and, from the C: prompt, type E: and press <ENTER> to
change to the CD-ROM drive. If you are using a CD drive letter other than E:, specify
the appropriate drive letter in the command.
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6. From the E: prompt, type CD VM then press <ENTER>. The \VM directory prompt
displays.

7. From the \VM directory prompt, type INSTALL and press <ENTER>. The message
“Setup is initializing, please wait...” displays.

8. A window displays which briefly describes the installation procedure. To continue
installing, click Continue or press <C>. The installation program presents a list of
drives from which you can select.

 

9. Select the drive to which the files should be installed. Use the down arrow key to
highlight the appropriate drive, then click OK. (Drives A and B are disk drives.) The
system prompts whether you want to install the system to the \CVR directory on the
specified installation drive.

 

10. Click Yes to install the system to the \CVR directory and continue the installation
process. If you click No, you are prompted to enter a destination directory.

 To facilitate system maintenance, it is recommended that you do not change the
default installation directories.

11. You are prompted whether you want to back up the voice mail system. If you select
Yes, the system backs up the CVR, CVR1, and REPAIR directories to the
\OSP_OLD directory, which contains CVROLD, CVR1OLD, and REPROLD
directories, respectively. It is strongly recommended that you select Yes to back up
the voice mail system.
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12. Wait while the system prepares to load files. A dialog box with installation options
and space requirements displays. The Space Requirements section of the window
displays the disk space required, based on the selected options, the space
availability, and the installation and boot drives.

 

13. Under Installation Options, leave all of the options selected:

• Program Files – Includes the executable files needed to run the messaging
system.

• Utilities – Contains the files necessary to run system modules, such as DialPlan
and Integrator.

14. Under Voice Files, select the language(s) that you are installing. Note that the
Sentinel attached to the PC controls the number of allowed languages allowed.

15. Under Voice Drivers, select the type of voice board installed in the system PC from
the drop-down menu.

16. Under Serial Integrations, verify that the option displayed is correct. If it is not, select
the appropriate option from the drop-down menu.

 You can exit the installation at this point by clicking Exit. After you select Install, you
cannot exit the installation process.

17. Click Install to install Octel 100 based on the selections.

 A small display appears to the left of the Disk Prompt window to show the
progression of the installation process. The graph represents the percent of hard
drive space and memory being used, as well as the progression of each file as it is
copied from the disk to the hard drive. If the Low icon comes on during installation,
do not be concerned.
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18. When the system then prompts you to indicate whether you want the messaging
system to launch automatically upon bootup, click Yes. This configures Octel 100 to
launch each time you restart the PC and allows you to run third-party maintenance
utilities from the RUNVM.CMD file. For information on modifying the RUNVM.CMD
file, see the topic, "Verifying Files After Installation," in Chapter 6, “Installing the
Software,” in the Implementation and Service Manual.

 

19. If you selected Yes in 18, you are prompted to indicate whether you want the UPS
monitor to load automatically upon boot up. Select Yes if the UPS is currently
integrated with the messaging system or you are planning to run UPS integration so
the UPS monitors messaging system status to recognize a potential interruption in
operation before it occurs. For additional information on the UPS monitor, see
Chapter 11, “Integrating with an Uninterruptible Power Supply,” in the
Implementation and Service Manual.

 Select No if you do not want the UPS monitor to load upon boot up.

 Programs that load prior to the desktop coming up under OS/2, such as UPS, display
a default OS/2 icon on the desktop rather than the custom icon.

20. If you installed a serial integration, you are prompted whether you want the serial
integration to launch automatically on bootup. Click Yes.

21. A dialog box displays informing you that the file installation is complete. Click OK to
continue with system configuration.

22. If you are upgrading from version 1.0x, the Convert window displays and the system
converts the existing database for use with the current version of the messaging
system. Wait while the database is converted. If a warning displays stating that you
must reconfigure inband templates, click Yes to continue. You will address this
warning later in this procedure. After the conversion is complete, click Exit. The
system creates a file, CONVERT.RPT that logs conversion activity.

 All versions are also upgraded for millennium compliance. The system creates a file,
UPGRADE.RPT, that logs conversion activity.

23. The Installation Setup Utility dialog box displays a list of utilities you can run to help
you configure the Octel 100 system.
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24. If you did not complete the steps in the note titled, “Migrating an Existing Octel
Messaging System to a Pentium PC,” skip to step 25. If you did complete the steps
in the note titled, “Migrating an Existing Octel Messaging System to a Pentium PC:”

a. Select Configure from the Installation Setup Utility list, then click Run. See the
PC Specification Sheet, provided with the new PC, for information on type and
number of voice and fax board installed in the PC. See Chapter 5, “Preparing
the Hardware,” in the Implementation and Service Manual for the default board
settings you must enter in Configure and Chapter 7, “Setting Up the System to
Recognize Voice and Fax Boards,” for information on running Configure.

b. When you exit Configure, you are prompted to reboot the PC if you made
changes. Do not reboot at this time.

c. Click OK to close the message box. The Installation Setup Utility displays.

d. Select Integrator from the Installation Setup Utility list, then click Run:

• If you migrated from version 1.0x, you must run the Integrator utility to
configure the system to use the correct inband templates for the switch to
which the messaging system is connected. For information on running
Integrator, see Chapter 8 “Integrating with the Phone System,” in the
Implementation and Service Manual.

• If you migrated from version 1.5 or higher, verify that the correct switch is
listed under Currently Installed Switch field:

- If the correct switch is installed, click Exit.

- If the incorrect switch is installed, install the switch to which the
messaging system is connected. For information on running Integrator,
see Chapter 8 “Integrating with the Phone System,” in the
Implementation and Service Manual.

e. Skip to step 26.

25. If you did not complete the steps in the note titled, “Migrating an Existing Octel
Messaging System to a Pentium PC:”

a. Select Configure from the Installation Setup Utility list, then click Run:

i. Under Installable Hardware, select the board type installed in the PC, then
click Configure. The Configure – Dialogic D4xD dialog box displays.

ii. Under Voice Board Type, select the type of voice board you recorded in step
2b.

iii. In the Hardware Interrupt field, enter the hardware interrupt you recorded in
step 2b.

iv. Under Shared Memory Addresses, verify that the default address displayed
matches the first shared memory address you recorded in step 2b. if there is
more than one voice board installed, click Add, scroll to the next setting you
recorded in step 2b, and click Done. Repeat for each additional installed
voice board.

v. Click OK to save any changes. The Configure dialog box displays.

vi. To close Configure, click Exit. A dialog box displays prompting you to reboot
the system for changes to take effect. Do not reboot the PC at this time.

vii. Click OK to close the message box. The Installation Setup Utility displays.
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26. Select Setup from the Installation Setup Utility list, then click Run. The General
Parameters tab displays.

a. If no message displayed during conversion in step 22 informing that you must
reconfigure inband templates, proceed with step 26d. If you did receive a
message during conversion informing you that you must reconfigure inband
templates:

i. Click the double arrow button in the lower-right corner of the screen to scroll
down to the Inband Page 2 tab and click it to select it. The Inband
Parameters Page 2 tab displays the inband templates created by the system
during conversion. If the phone switch does not support inband templates,
no templates are displayed on this tab and you should proceed to step 26d.

ii. Follow the procedures under the heading “Creating, Modifying, and Deleting
Inband Templates” in Chapter 8, “Integrating with the Phone System,” in the
Implementation and Service Manual to modify the templates to function
properly with the phone system.

b. Click the double arrow button in the lower-right corner of the screen to scroll
down to the Voice System tab and click it to select it. The Voice System
Parameters tab displays.

c. View the value for the RECDTMFand PLAYDTMF parameters. If the values are
not set to at least 5, change each to 5 by highlighting the value, typing 5 and
pressing <ENTER>.

d. To save the settings, select Save from the File menu.

e. To close System Setup, select Exit from the File menu. After a few moments,
the Installation Setup Utility list displays.

27. Click Done to exit the Installation Setup Utility dialog box. The system then
completes the installation. When installation is complete, the system displays a
message reminding you to restart the computer for any changes to take effect. Do
not restart at this time.

28. To close the dialog box and return to the OS/2 window, click OK.

29. To verify that the upgrade was successfully performed, you must review the upgrade
reports:

a. From the E:\VM prompt, type C: and press <ENTER>. The C: prompt displays.

b. From the C: prompt, type E C:\CVR1\upgrade.rpt then press <ENTER>.
An OS/2 editor window displays the contents of the upgrade report. Scroll
through the report to determine if any errors were logged during the upgrade. If
not, proceed with step 29c. If errors were logged during the upgrade, contact a
technical support representative before proceeding.

c. If you upgraded from version 1.5 or higher, skip to step 29d. If you upgraded
from version 1.0x, select Open from the File menu. When the Open dialog box
displays, select CONVERT.RPT from the File listbox, then click Open. The
contents of the CONVERT.RPT file display. Scroll through the report to
determine if any errors were logged during the upgrade. If not, proceed with step
29d. If errors were logged during the upgrade, contact a technical support
representative before proceeding.

d. Double-click the icon in the upper-left corner of the window to exit the editor.
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30. If the system was running version 1.0x, skip to step 31. If the system was running
version 1.5.x or 2.02.x, copy the contents of the \CVR1 directory to the \BACKUP1
directory:

a. From the C: prompt, type XCOPY C:\CVR1\*.* C:\BACKUP1 and press
<ENTER>. The contents of the \CVR1 directory are copied to the \BACKUP1
directory. Record the number of files copied.

b. To verify that the files were copied, from the C: prompt, type DIR C:\BACKUP1
and press <ENTER>. Verify that the number of files in the \BACKUP1 directory
match the number of files that were copied in step 30a.

31. To exit the OS/2 window, type EXIT then press <ENTER>.

32. Verify that the OS/2 desktop archive and recovery choices options are enabled:

a. Click the right mouse button on an empty area of the OS/2 desktop and select
Settings from the menu that displays. The Desktop – Settings window displays.

b. Click the Archive tab.

c. In the Archive System Files box, make sure that the option to Create system
archive at each restart is enabled.

d. In the Display Recovery Choices Screen box, make sure that the option to
Display Recovery Choices at each restart is enabled.

e. In the Timeout for Recover Choices screen field, enter 5 if it is not already set
to 5.

f. Double-click the icon in the upper-left corner of the window to save the settings
and close the window.

33. Remove the CD-ROM.

34. Restart the PC:

a. Click the right mouse button on an empty area of the OS/2 desktop and select
Shut down from the menu that displays.

b. When you are prompted whether you want to close all windows and active
programs, click OK.

c. When prompted to shut down or reboot, press <CTRL+ALT+DEL> to restart the
PC.

35. If you did not complete the steps in the note, “Migrating an Existing Octel Messaging
System to a Pentium PC,” skip to step 36. If you did complete the steps, “Migrating
an Existing Octel Messaging System to a Pentium PC, you must connect the new
PC:”

a. Remove the voice and fax lines from the current messaging system PC and
connect them to the new messaging system PC.

b. If the current messaging system was connected to a UPS, plug the new
messaging system into the UPS. If you are using UPS integration, you must also
connect the serial communications cable.

c. If the current messaging system was connected to a printer, connect the printer
to the back of the Sentinel on the new messaging system’s parallel port.

d. If the current messaging system is using a Serial integration, see the
Configuration Note for the switch to verify that the new messaging system PC is
properly configured for the integration (such as disconnecting the current
messaging system from the serial integration device and connecting the new
messaging system to the device).



UPGRADING TO OCTEL 100 RELEASE 3.2 FROM OPC/SIGNATURE PERFORMER 1.0 AND HIGHER

101-1881-000 COMCODE 108623240 15
585-313-141 NOVEMBER 1999, ISSUE 1

e. If you removed a token ring card from the current messaging system, you must
now install the token ring card in the new messaging system PC:

i. Remove the cover from the new messaging system PC.

ii. Select a 16-bit expansion slot for installing the network card. Unscrew the
cover on the slot (located at the rear of the PC chassis, top center) and
remove it.

iii. Apply equal pressure to both ends of the board and push down firmly to seat
the board in the slot. The board should slide down easily most of the way. If
you feel any resistance, check the alignment of the board. Make sure the
board is properly seated in the slot.

iv. Fasten the board’s metal bracket with the retaining screw. Make sure the
connection on the back of the board is accessible from the rear of the PC
chassis before securing the screw.

v. Replace the PC’s cover.

vi. Secure the network connection cable or jack into the network card.

f. Turn on power to the PC. If the messaging system is configured to launch
automatically on bootup, it launches. Otherwise, the OS/2 desktop displays.

WARNING: In step 36, you must launch Call Analysis, even if you determine that
you are not required to actually run the utility. This is required
because, when you launch Call Analysis, the TONE.PAR file is
adjusted for this version of the software.

36. Complete the following steps to launch Call Analysis:

a. Shut down the messaging system if it is running:

i. Log into the messaging system as a Level 2 or 3 supervisor.

ii. To shut down the system, select Exit from the File menu. A dialog box
displays a message prompting you to indicate how to shut down the system.

iii. Click OK to perform the shutdown. A dialog box displays a message asking
if you want to wait for channel activity to cease. Wait for channel activity to
cease. Do not click Force. When all the ports are inactive, the system shuts
down.

b. Double-click the Octel icon to open the program folder.

c. Double-click the Call Analysis icon in the program folder. The Call Analysis for
OS/2 dialog box displays.

d. Click Continue to load required tone templates. The Call Analysis dialog box
displays.

e. You may need to run the Call Analysis utility. For guidelines for running the Call
Analysis utility, see Chapter 9, “Defining Phone System Signals,” in the
Implementation and Service Manual. If you determine that you are not required
to run the Call Analysis utility, click Exit to close the utility. If you determine that
you need to run the Call Analysis utility, see Chapter 9, “Defining Phone System
Signals,” in the Implementation and Service Manual.

f. If the messaging system is not already running, start it by double-clicking the
program icon in the program folder.

 If the voice system does not start up as it should, contact a technical support
representative immediately.
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37. It is essential that you test any inband templates currently defined for the switch to
ensure the templates function as they should. To test the inband templates:

a. Log into the messaging system as a Level 2 or 3 supervisor.

b. Select System Setup from the Options menu on the main window. The General
Parameters tab displays.

c. Use the right arrow button in the lower-right corner of the screen to scroll down to
the Inband Page 2 tab and click it to select it. The Inband Parameters Page 2 tab
displays the inband templates currently defined for the system.

d. Test each template by calling into system, performing the function associated
with the template, and verifying that the call is processed correctly. For
additional information on making any necessary modifications to the inband
templates, see Chapter 8, “Integrating with the Phone System,” in the
Implementation and Service Manual.

e. After you have tested each inband template and made necessary modifications,
save the templates by selecting Save from the File menu.

f. To exit System Setup, select Exit from the File menu.

g. If you made any modifications to the inband templates as a result of the testing
you performed, select Restart Voice System from the Options menu to restart
the messaging system. If it was not necessary for you to make modifications,
you do not need to restart the system.

38. If you were not using custom phrase files in the [LANGUAGE]1.O32,
[LANGUAGE]2.O32, or [LANGUAGE]3.O32 files, skip to step 39. If you were using
custom phrase files, you must use V-Edit to restore the phrases individually from the
back \CVR directory. For information on using V-Edit to restore phrases, see the
heading “Adding Segments to Phrases” in Chapter 15, “Recording and Editing
Prompts,” in the Implementation and Service Manual.

 Make sure you restore the phrases to the correct phrase number.

39. It is important that you test the integration with the switch and the messaging system
software features to ensure the entire system works as it should. A test plan you can
use to help you exercise system features and options and confirm they are
functioning appropriately is provided in Chapter 24, “Testing and Troubleshooting the
System.”

40. If you completed the procedure, “Migrating the Messaging System to a New PC,” you
must install the Graham Utilities software on the new messaging system PC. See the
topic, “Installing and Configuring Graham Utilities,” in Chapter 6, “Installing the
Software,” in the Implementation and Service Manual.

41. If the messaging system was running Visual Mailbox, the Voice Fax Server is
automatically upgraded when you upgrade the voice mail system. However, you
must upgrade the Visual Mailbox Client. See the topic, “Installing the Client Software
on the LAN Server,” in Chapter 19, “Installing and Configuring Visual Mailbox,” in the
Implementation and Service Manual.

42. If you completed the procedure, “Migrating the Messaging System to a New PC,”
and the current messaging system was running Visual Mailbox, you must install
OS/2 Warp networking support. See Chapter 19, “Installing and Configuring Visual
Mailbox,” in the Implementation and Service Manual for information on installing the
necessary software.
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Post Upgrade Considerations

Please be aware of the following important post upgrade considerations:

• Call Analysis has been improved to use custom tone information for transfers
instead of the Dialogic defaults. Due to these enhancements, some systems may
experience problems with call progress after the upgrade. If this occurs, re-run call
analysis so that the system can obtain the required tone information.
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Issues Addressed in Octel 100 Version 3.2

The following program changes have been made in Octel 100 Version 3.2:

• Three parameters new are now supported by the ICONFIG utility: MWLWAIT,
NAKQUEUE, and MWLQSIZE so that they will be saved in the SI.CFG file and no
longer be overwritten when ICONFIG is run.

• A problem was addressed where an access violation occurred while attempting to
print a report while a different report is still in progress.

• Corrected an issue where DID Calls to a busy station failed integration.

• Corrected an issue where changes to Greeting by Port setup changes were always
properly saved when the “Copy to Port…” option was used.

• Corrected an issue where messaging system database files were not always
accessible after the messaging system was shut down on systems with Visual
Mailbox.

• Corrected the Go to Automated Attendant, Get Mailbox and Go to Voice Mail, Get
Mailbox inband templates for the Lucent Legend and Partner switches so the correct
action is executed.

• The OS/2 option to create an archive at each system restart is now enabled. This
allows the most recent desktop settings to be recovered if necessary.

• Corrected an issue where an incorrect prompt was voicing for the Go to VM, Get
Mbox function.

• Corrected an issue where ICONFIG settings were not being retained after an
upgrade.

• Improved inband templates for serial integrations.

• The UPS Integrator can now be minimized to an icon and resized properly.

• An issue with OS/2 that could cause incomplete shutdowns has been addressed by
upgrading to OS/2 FixPak 40 on existing systems.

• Corrected incorrect MI codes in SWDATA.TXT for Mitel SX2000 COV integration.

• An issue was corrected where a blank dialog box displayed during a CEO to Octel
100 upgrade.

• Corrected an issue where, when upgrading from OPC 1.02, the dialog box instructing
the installer to review the inband templates and make sure they are configured
properly did not display.

• Corrected an issue where the Dialogic D/42D-NS was not receiving the proper
Caller-ID on the new Norstar Compact ICS KSU.

• Modified Configuration Note for the NEC 2000 to include requirement of adding –
PXXXX to NEC.EXE file.

• Modified the SWDATA.TXT file to correct incorrect default codes for some functions
on Lucent switches.

• Updated OctelNet to send more descriptive return codes for administrative
responses.

• Corrected an issue where message confirmations to 10-digit mailboxes on an
OctelNet node were not working properly.

• Corrected an issue in SMDI.TPT that generated an error message.
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• Added MWI refresh. See, “Refreshing Message Indicators,” in Chapter 23,
“Maintaining the System,” in the Implementation and Service Manual.”

• Corrected an issue where the runvfs.cmd could not be shut down.

• Added Serial Number parameter to Networking parameters in System Setup. See
the Serial Number parameter description in Chapter 13, “Setting Up the System,” in
the Implementation and Service Manual.”

• Corrected an issue where the System Setup utility could not be accessed from the
desktop when the OS/2 System Setup Icon View was open.

• Tone tables have been added for the Lucent Prologix switch.

• Changed the SI.CPP file to use a 4-digit year instead of 1 2-digit year. The result is
the Serial integration log now correctly processes dates after 1999.

• Addressed an issue where NameNet entries were sometimes being deleted in
isolated situations.

• Corrected an issue that caused an incorrect time to be voiced when a subscriber
received a message that was sent with Future Delivery to a distribution list.

• Added new D42NS.FWL file.

• Corrected an issue where the Mailbox Information Report was not correctly updating
the Date of Last Use parameter.

• Corrected an issue where users cannot send messages to an OctelNet node if the
number of retries has been exhausted by administrative calls to the note.

• Removed support for the MD110 integration.

• There is a limitation on the Norstar switch that only permits 32 message indicator
requests to be turned on a particular channel. This release of the Octel 100
overcomes this limitation.
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Notes:


